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Install Software and Fonts 
Already on Mac (Applications Folder) 

• TextEdit    • Calculator (Optional) 

Freeware 
1. Drag Ukelele 1.83 folder to Applications folder. 
2. Double click UnicodeFontInfor_1_5_1.dmg. Drag Unicode Font Info.app to Applications 

folder. 
 

• Ukelele 1.8.3 (SIL) 
o http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&item_id=ukelele&_sc=1 
o http://www.macupdate.com/info.php/id/14495 

• Unicode Font Info (Andrew Thomson) 
o http://pixel.recoil.org/code/unicodefontinfo/ 

• Img2Icons (ShinyFrog) – http://www.img2icnsapp.com/ 
Not in Class folder 

Freeware Font 
1. Shut down all text editing apps (e.g. Text Edit, Dreamweaver, Word) 
2. Open ArevFontFamily Folder.  

3. Place four  .ttf files in ~/Library/Fonts 
Note: “~” means the users folder. Click Home (white house) icon to access. 

 

If font not recognized in an application, then try these 
• Quit and restart application 
• Look for font at the bottom of the font list (with Asian fonts). 
• Arev Sans font Download (tavmjong) 

o http://tavmjong.free.fr/FONTS/ 

Free Logic Keyboard (Penn State) 
1. Shut down all applications. 
2. Open LogicKeyboard folder.  
3. Place LogicSymbol.keylayout and LogicKeyboard.icns in ~/Library/Keyboard Layouts. 
4. You must reboot computer any time you install a new keyboard layout. 
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Nano Review of Unicode & Input Utilities 
An Encoding Scheme 

• An encoding scheme assigns a number to each possible character or glyph within a script or 
set of scripts. 

• Unicode aims to assign a number (aka code point) to each possible glyph in all scripts ever 
used in the world. 

Example codes 
• Note: Unicode code points are typically given in hexadecimal (base-16) values. 

CODEPOINT GLYPH – GLYPH NAME 

U+0041 A – Latin Capital Letter A 

U+0061 a – Latin Small Letter A 

U+00C0 À – Latin Capital Letter A with Grave (Precomposed) 

U+00C1 Á – Latin Capital A Letter with Acute (Precomposed) 

U+0391 Α – Greek Capital Alpha 

U+03B1 α – Greek Small Letter Alpha 

U+2203 ∃   – There exists 
U+2208 ∈– Is an element of 
U+2209 ∉– Is not an element of 
U+0020  – Space (i.e. a blank space) 

U+00E9 " –Quotation Mark 

U+201C “ –Left Double Quotation Mark 

U+201D ”–Right Double Quotation Mark 

 

Lookup codes 
• http://www.unicode.org/charts 
• http://www.unicode.org/Public/UNIDATA/UnicodeData.txt 
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 Inputting Unicode Text 
 

The Role of the Font 
A properly encoded font matches the encoding number with the character specified in the 
encoding scheme.  

A Unicode encoded font would always display character ∃  in position x2033 (x = hex number) and 
∈  in position x2209. Conversely, a properly encoded font would never display ∃  in any other 
position except x2033. 
 

Keyboards Have Numbers Also 
Apple OS X 

 
Partial schematic of Apple keyboard numbers. 
 
U.S. Keyboard 
Key 1 = U+0073 = Latin Small Letter S 
Shift+Key 1 = U+0053 = Latin Capital Letter S 
 
Greek 
Key 1 = U+03C3 = Greek Small Letter Sigma (σ) 
Shift+Key 1 = U+03A3 = Greek Capital Letter Sigma (Σ) 
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Overview of Different Input Methods  
for Mac 

There are several utilities available to help you insert or type accented letters and other special 
characters. To pick one that could work for you, check the grid below to see what software and 
hardware you need.  

 

METHOD SOFTWARE/HARDWARE 
U.S. Default + Accent 
Codes 

These are enabled by default on all U.S. Macs. 
 

U.S. Extended 
Keyboard 

This utility significantly expands the accents available to 
long marks, Central European characters and more. 

Unicode Hex Input A utility which allows you to generate any Unicode 
character by pressing the Option Key plus the  

Language Keyboards Change key settings to characters needed for a 
language. Apple includes many but others are available 
as freeware. 

Character Palette A utility which allows you to insert Unicode characters 
including a large number of symbols 

 

Open Text Edit (Applications Folder) 
Text Edit is an ideal application to test a keyboard because 
• It recognizes all of Apple’s font specifications (esp Middle Eastern/South Asian) 
• It switches fonts if you type a glyph not found in the current font. 
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U.S. Standard + Accent Codes 
These accent and character codes are accessed with the Option key. 

Basic Codes 
To insert these characters, press the Option key (bottom of keyboard) then other "code" key to make 
the symbol appear. 
Example 1: To input French ç (Option+C), hold down the Option, then the C key. The ç will appear. 
Example 2: To input French Ç (Shift+Option+C), hold down the Shift key, then the Option key,then 
the C key. The ç will appear. 
 

Other Foreign Characters Currency Symbols 
Symbol Codes 

¡ Option+1 

¿ Shift+Option+ ? 

ç,Ç Option+C 
Shift+Option+C 

œ,Œ Option+Q 
Shift+Option+Q 

ß Option+S 

ø,Ø Option+O 
Shift+Option+O 

å,Å Option+A 
Shift+Option+A 

æ,Æ Option+’ 
Shift+Option+’ 

(apostrophe key) 

«» Option+\ 
Shift+Option+\  

Symbol Code Notes 

¢ Option+4 Cent Sign 

£ Option+3 British Pound 

¥ Option+Y Japanese Yen 

€ Shift+Option+2 Euro 

ƒ Option+F Dutch Florin 
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Letters with Accents (Actions) 
Accented Vowels 

This list is organized by Accent type. The sample shows a letter with that accent, and the Notes 
present any special comments about using that accent. 
For the Template, the symbol "V" means any vowel. The format is to hold the first two keys 
down simultaneously, release, then type the vowel you wish to be accented. 

 
Accent Sample Code Notes 

Acute ó,Ó Option+E,V  

Circumflex ô,Ô Option+I,V  

Grave ò,Ò Option+`,V  

Tilde õ,Õ Option+N,V Only works with n,N,o,O,A 

Umlaut ö,Ö Option+U,V  

 
Example 1: To input the letter ó, hold down the Option key, then the E key. Release both keys 
then type lowercase o. 
Example 2: To input the letter Ó, hold down the Option key, then the E key. Release both keys 
then type capital O. 
 

Actions and Dead Keys 
A specification which matches combinations of keystrokes with the right glyph. The Accented 
Vowel keystrokes are specified by a set of actions.  
 
The Option+E key does not generate a single character but “holds” until a vowel is selected, then 
inserts the character for a vowel plus acute accent. The Option+E is a dead key which takes the 
user to another state where typing a = á. 

 
Typing Practice 

América  São Paulo  Übermann 
déjà vu  hôtel    Ñandutí  
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Activate Apple Keyboards 
Apple includes a number of keyboard utilities which change the mapping between the keys and the 
characters generated. 
 

Activate the Keyboard (Leopard) 
1. Go to the Apple menu and open Systems Preferences. 
2. Click the International icon on the first row of the Systems Preferences panel. 

 
System Preferences Window. 

3. Click the Input Menu tab and check the keyboards you want activated.  

 
List of available keyboards on this system 

 
Note: If you do not see the keyboard you need to activate, you may need to install them from an 
OS X CD or download the most recent version of OS X from Apple. Make sure the appropriate 
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Localized Files are checked during the installation set-up wizard.  
 

Minimal Keyboards to Activate 
You will need to activate the following keyboards to complete the rest of the exercises in this 
handout. 

• Unicode Hex Input 
• U.S. Extended 
• Russian and Russian Phonetic 
• Logic Keyboard 
• Character Palette 
• Keyboard Viewer 
• Any other keyboards of your choice. 

 

Switch Between Keyboards 
If you want to switch between switch between the International keyboard and other keyboards, do 
the following: 
1. Make sure you have activated your target keyboards following the instructions above. You 

should see an American flag icon in the upper right of your computer screen. This icon indicates 
that more than one keyboard is active on your system. 

 
�U.S. flag for the U.S. keyboard 

2. Open an application such as a word-processor, HTML editor, spreadsheet or any other 
application in which you need to input text. 

3. On the upper right portion of the screen, click on the American flag icon ( ). Use the 
dropdown menu to select the U.S. Extended Keyboard ( ) which symbolized as the U.S. flag 
with a U. 
Note: If the keyboard is grayed out, then the application is too old to support the Extended 
keyboard. 

 
The keyboard will be selected and the appropriate font selected (except for some Adobe 
applications). 

Change Default Keyboard 
To change the default keyboard, go to the Finder (i.e. where you navigate to folders and open 
applications and switch the keyboard. 
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U.S. Extended Keyboard Codes 
• These codes only work within the U.S. Extended Keyboard 
• They work with many letters, but not all letters 
• Math option codes are not available in the U.S. Extended Keyboard 

 
Accent Sample Code Notes 

Acute ý,Ý Option+E,X  

Circumflex ŵ,Ŵ Option+I,X Different from U.S. Keyboard 

Macron ō,Ō Option+A,X  

Brave ŏ,Ŏ Option+B,X  

Cedille ş,Ş Option+C,X  

Polish Ogonek ǫ,Ǫ Option+M,X  

Hachek č,Č Option+V,X  

Double Acute 
Double Grave 

ő,Ő 
ȍ,Ȍ 

Option+J 
Shift+Option+Y,X 

 

Dot Above 
Dot Below 

ȯ,Ȯ 
ọ.Ọ 

Option+W,X 
Option+X,X 

 

Strikethrough ł,Ł Option+L,X Only, O,L, lowercase I 

Thorn þ,Þ Option+T 
Shift+Option+T 

 

Eth ð,Ð Option+D 
Shift+Option+D 

 

Circle ů,Ů Option+K Only u,a 

Arch ȏ,Ȏ Shift+Option+S,X  

Grave ỳ,Ỳ Option+`,V  

Tilde ẽ,Ẽ Option+N,V Only works with n,N,o,O,A 

Umlaut ẅ, Option+U,V  
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Unicode Hex Option Keyboard 

This utility allows you to input characters based on their Unicode hexadecimal value. 

Activate Keyboard 
1. The Unicode Hex Input  keyboard can be activated as a “keyboard” in International options 

within the System Preferences. See the instructions for activating a keyboard in the “U.S. 
International Section.” 

2. Open any application such as which supports Unicode input. 
3. Choose Unicode Hex Input from the International (flag icon) menu on the upper right. 
4. Type Option+<the hexadecimal code value> for the character (see details below). 

Note: The code must be at least 4 digits long 
 

Typing Exercise 
What is this sequence?      And this Sequence? 

Option+03BA Option+0043 
Option+03BF Option+006F 
Option+03B4 Option+0064  
Option+03B5 Option+0065  
 

Decimal Versus Hexadecimal Codes 
Unicode character codes can be listed as hexadecimal (e.g. U+03BA) or decimal (954). Depending on 
your application, you may need one or the other. 
For example: Windows ALT Codes always use the decimal value. 
 

If Above U+FFFF 
If the code is above U+FFFF (i.e. five or more hex digits), then code must be entered as two 4-digit 
(16-byte) sequences (or the UTF-16 Surrogate Pair). 
 

e.g. �� (Phonecian Letter Mem) = U+1090C = 
Option+(D802+DDOC) release 

See http://en.wikipedia.org/wiki/UTF-16/UCS-2#Encoding_of_characters_outside_the_BMP for algorithm 
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Character Palette 
The Character Palette is a Mac utility which allows you to insert individual accented characters, 
symbols and characters from other scripts.  

Activate Character Palette 
The Character Palette can be activated as a “keyboard” in International options within the 
System Preferences. See the instructions for activating a keyboard in the “U.S. International 
Section.” 

Open Character Map  
1. Open any application such as which supports Unicode input. 
2. Choose Show Character Palette from the International (flag icon) menu on the upper right. 

Basic Symbols 
3. In the new window, switch the View drop-down menu to Roman. 
4. Select the type of symbol in the left column. 
5. Highlight the symbol needed, then drag the symbol into the document or click Insert.  

 
Character Palette – Roman View Options 
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Roman View Options 
1. Math – Math symbols 
2. Arrows – Arrow variations 
3. Parentheses – Bracket variations 
4. Currency Symbols 
5. Punctuation – Includes foreign language punctuation 
6. Miscellaneous, Crosses, Stars/Asterisks – multiple symbols 
7. Latin – basic English alphabet 
8. Accented Latin – Accented letters and non-English symbols 
9. Digits – Fractions, circled numbers, superscripts/subscripts 
10. Greek – Basic Greek symbols with access to accented Greek 
11. Ornamental Punctuation and Braille – more symbols 

Additional Symbols 
To view symbols from multiple scripts, switch the View menu in the upper left to All Characters. 
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About Other Language Keyboards 
What Apple Provides 
See list on http://tlt.its.psu.edu/suggestions/international/keyboards/mackey.html 
Note: This list is reconstructed over time. Minor inaccuracies may occur. 
 

QWERTY/Phonetic/Transliterated vs. Native Layout 
Keyboards can be split into two types: 
 
QWERTY/Phonetic/Transliterated 

Keys are mapped to match English (Latin) letters and characters in other script. For instance 
Latin "S" would be Cyrillic "C", Latin "R" would be Cyrillic "Ρ" Latin "P" would be Cyrillic "Π", 
and so forth. 
Recommended for U.S. foreign language students. 
 

Native Layout 
Matches native typewriter layout 
Preferred by many native (but not all) native speakers. 

 

Third Party Keyboards 
Covers scripts not supported by Apple. Many are freeware. 

• http://www.redlers.com/downloadkeyboard.html 
• Do a Google Search 

 

Make Your Own! 
• Ukelele – http://www.sil.org/computIng/catalog/show_software.asp?id=94 
• XML Spec – http://developer.apple.com/technotes/tn2002/tn2056.html 
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 Creating Your Own Keyboard 
Why On Earth…. 

• Efficiency: Palettes are good for the occasional exotic character, but becomes cumbersome 
when entering multiple characters over the course of a long document. 

• Accessibility: Typing causes less strain to hand muscles than repeated mouse movements. 
• Mental processing:  Mnemonic keystrokes easier to process and again, quicker is more 

efficient. 
 

Possible Scenarios (Not Already Built) 
• Include most frequently used technical symbols  

o Logic Symbols 
o Currency Symbols (Global pricing?) 
o Astronomy/Meterology (Planets, weather symbols) 
o Thermodynamics (calculus, dotted letters) 
o Chess/Poker/Mahjong publications 
o Publications on religion/spirituality 
o Most technical fields use only a fraction of the Math and other symbol blocks 

• Missed PC version of a layout 
U.S. International (PC) on the Mac 
http://www.brockerhoff.net/usi/index.html 

• No keyboard for your language’s orthography/region yet 
• Special characters for archiving historical documents (e.g. Insular Celtic “D” = Ꝺ) 
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Planning The Keyboard 
Partial set used for this class. Installed Logic Course may have different layouts. 
 
Character Key Stroke (Including Dead Keys) Unicode Code Point 

∀ Option+A U+2200 
∃ Option+E U+2203 
∄ Option+\,E (Action) U+2204 
∨ Option+V U+2228 
∪ Shift+Option+V U+222A 
∧ Option+7 U+2227 
∩ Shift+Option+7 U+2229 
≡ Option+- U+2261 
≢ Option+\,- U+2262 
∈ Option+3 U+2208 
∉ Option+\,3 U+2209 
⊃ Shift+Option+> U+2283 
⊅ Option+\,> U+2285 
⊂ Shift+Option+< U+2282 
⊄ Option+\,< U+2284 
↔ Shift+Option+- U+2194 
→ Option+; U+2192 
← Option+K U+2190 
¬ Option+L U+00AC 
~ Shift+` (Tilde Key) U+007E 
ℙ Option+P U+2119 
ℚ Option+Q U+211A 
ℝ Option+R U+211D 
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Planning The Keyboard (Blank) 
 
Character Key Stroke Unicode Code Point 
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Create Keyboard in Ukelele 
 

Create Template Based on U.S. Standard 
Note: The U.S. default chosen because many math symbols already built in. 
 

1. Open Ukelele from the Applications folder. You will see a small ukelele icon in a popup. 
2. In the new layout window, select Copy of other keyboard layout.  Click OK. 

Note: If you don’t see pop-up to create new layout, go to File » New. 

 
3. In the file browsing window, go to Applications/Ukelele 1.83/System Keyboards/Roman/ 

and select U.S..keylayout. 
4. A U.S. keyboard display opens. Save the keyboard as LogicClass.keylayout. 
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Change Basic Option Key Assignments 
1. Switch to the Unicode Hex keyboard. 
2. Press Option+A. You will see that å is currently assigned to this sequence. The keys with a 

white outline are “dead keys” associated with actions. 

 
3. Press Option+A again, then double click on that key in the virtual layout. A pop-up window 

opens showing the current assignment of that key. 

 
4. Place your cursor in the pop-up text area and highlight å. Type Option+2200 (in Unicode Hex 

keyboard) or &#x2204;. The display changes to ∀ .  Click OK to close the Window. 
 
Note: Other input options include drag and drop from the Character Palette, inserting from 
the Character Palette or copy and paste from another (Unicode) document including Web 
sites. 

5. Click Option+A to verify change of å to ∀ .   
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Override a Dead Key 
1. Press Option+E in Ukelele. The white outline indicates that this is currently a dead key which 

is associated with an action to assign an acute accent over a vowel. 
2. Press Option+E again, then double click on that key in the virtual layout. A pop-up window 

indicating it’s a dead key appears. 

 
3. Click the Delete option. The window to change the key assignment appears. Enter 

Option+2203 (Unicode Hex) for ∃. 
 

Adding A Dead Key Action 
In this section we will add the Option+\ dead key such that  

• Option+\,E = ∄ 

• Option+\,3 = ∉ 

• Option+\,- = ≢ 
In this case the Option+\ key is a dead key. 

1. From the Keyboard menu select Edit Dead Key. 
2. A window of predefined dead keys appears (if they exist). Click New to create a new dead 

key. 
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3. A window stating none opens. Type Option+\. A new state (State 1) appears in the list of 
states and a blank keyboard opens. 

 
4. Click the E key location. Input ∄ or &#x2204;. 
5. Input the other “not” or strikethrough characters at the appropriate key locations.  
6. To complete the dead key specification, from the Keyboard menu select Finish Dead Key. 

The basic key assignments should reappear and only the none state should be visible.  
7. Press Option+\. You should see only a white rectangular outline, indicating that it is now a 

dead key. 

Change Name of Dead Key State 
1. From the Keyboard menu select Edit Dead Key. 
2. Select State 1 from the menu. Click OK. 
3. Type in new name (e.g. “Not Slash”) in the next window’s text field. Click OK to exit. 

Add A Terminator 
A terminator is what Option+\ displays until the sequence is complete. Currently Option+\ 
displays nothing, but it could display a “placeholder” /.  

1. From the Keyboard menu select Edit Dead Key.  
2. Select the state you just created in the menu. Click Existing. 

Note: If this option is grayed out, then make sure you have performed steps #1-2. 
3. From the Keyboard menu select Change Terminator. A window with the blank dead key 

appears. 
4. Open the Character Palette. Select the Punctuation option on the left.  
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5. Drag the “/” (solidus) character onto the dead key in the pop up. Click OK to exit. 

 
Terminator set to forwards slash. 

6. To exit the dead key edit mode,  select Keyboard » Finish Dead Key. 

Load and Test 
1. Shut down all applications. 
2. Place .keylayout folder in either  ~/Library/Keyboard Layouts/ (just one user account) or  

/Library/Keyboard Layouts/ (all accounts). See details below. 
a. On your desktop (i.e. Finder) go to the File window then New Finder Window. 
b. Open your Users folder clicking the house icon on the left (or click the Macintosh HD 

icon if you want to install the font for all users). 
c. Open the Library folder then Keyboard Layouts folder. 
d. Drag LogicSymbols.keylayout file into this folder. 

3. Reboot the Mac, then activate keyboard from the International options in System 
Preferences. 

4. Open TextEdit, switch to this keyboard and test option keys. 
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Other Options 
View Keyboard Numbers in Ukelele 
To view keyboard number codes,  

1. Go to Keyboard » Show Key Code.  
2. Press key to reveal the number of that key. 
3. To hide the window, go to Keyboard » Hide Key Code. 

 

Create the Keyboard Icon 
The image associated with your keyboard is an .icns image file. 

1. Find or create an image file of an appropriate shape (size not important yet) which can be 
legible at small sizes. File should be about 300 x 300 pixels. 
Note: Format can be GIF, PNG, JPG or other common image format. 

2. Open img2icns.app (if available). A popup window opens. 
3. Drag PNG image file from desktop into dotted box. The box closes and a .icns file will be 

created. 

 
Drag PNG image into dotted box above to create a .icns file. 

4. Check preview for size and legibility, then click the File (folder icon) to select location for 
output. 
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5. Click the Icns icon to select location for output. Click Choose to trigger conversion. 
6. Give the .icns file the same name as your keyboard. For instance if your keyboard is 

foo.keylayout, then the image must be foo.icns. 
 



Unicode Text Input Page 29 CALICO 2009 

 

Apple Keyboard XML 
Open XML File 
To view the XML, open a .keylayout file in TextEdit, BBEdit or other text edit editor. 
 

Apple’s Official Specification 
http://developer.apple.com/technotes/tn2002/tn2056.html 
 

Some Notes & Example Code 
<keyboard> - root and name of keyboard 
<keyboard group="0" id="0" name="Logic33" maxout="1"> 

 
<layout> (See Apple Docs) 
<modifierMap> (Controls dead keys such as Shift, Option, Caps Lock) 

<keyMapSelect> (Assigns dead keys a number) 
 
<keyMapSelect mapIndex="3"> <!-- Option = State 3 --> 
            <modifier keys="anyOption"/> 
</keyMapSelect> 
 

<keyMapSet> (Where keys/output specified) 
<key> (the assignment) 
<keyMap index="3"> 

<key code="0" output="∀"/> 
<key code="1" output="&#x00df;"/> 

... 
<key code="14" action="14"/> <!-- E key interaction w/ dead key --> 

... 
</keyMap> 
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<action> (Where interactions with dead keys specified) 
<action id="14"> 

<when state="none" output="e"/> 
<when state="Not Slash" output="∄"/> 
<when state="s1" output="&#x00e9;"/> <!-- x00e9 = é --> 
<when state="s2" output="&#x00e8;"/> 
<when state="s3" output="&#x00ea;"/> 
<when state="s4" output="&#x00eb;"/> 

</action> 
 

<terminators>  
 
<terminators> 

<when state="Not Slash" output="/"/> 
<when state="s1" output="&#x00b4;"/> <!-- x00b4 = ´ --> 
<when state="s2" output="`"/> 
<when state="s3" output="&#x02c6;"/> 
<when state="s4" output="&#x00a8;"/> 
<when state="s5" output="&#x02dc;"/> 

</terminators> 
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Non-Western Scripts 
  

Syllabary & South Asian 
• Consonants typically are “dead keys” 
• Check out the XML 

 

Linear B Keyboard in Ukelele 
http://www.geocities.com/ale_vatri/ (Allesandro Vatri) 

 

Non-Latin Scripts (e.g. Greek, Cyrillic) 
Keyboard XML differs in some ways from Latin keyboards. Use a non-Latin keyboard as a basis in 
Ukelele or inspect XML. 
 

RTL Scripts 
RTL direction built into the characters, but directionality of punctuation (e..g ()) a concern 
Check out the XML as well 
 

CJK Scripts 
Often built with alternate palettes similar to the Character Palette (but with options to type character 
by Western pronunciation or stroke). That is another seminar… 
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Appendix 1: Does This Font Have My Glyph? 
In many cases (e.g. phonetics, math symbols, non-Latin script), a software application will continue 
to output text but actually switch fonts behind the scenes. 
 

Background Font Switch – Quick Demo 
1. Open Word and switch to Unicode Hex Input or the Logic Keyboard. 
2. Set the font to Palatino. 
3. Type some English text, then type or insert a logic symbol, then type some English text again. 

Note: The English text after the logic symbol is likely not Palatino 

Unicode Font Info Application 
This application allows you to inspect fonts by name and also Unicode blocks in each font. 

 
This palette shows available Dingbat characters in the Linux Libertine font. 

Download: http://pixel.recoil.org/code/unicodefontinfo/index.html 

Character Palette 
Highlight a character and click arrow besides Font Variation to display variants in multiple 
fonts. Some processing time may be involved. 
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Appendix 2: Fonts for Phonetics and Other 
Obscure Scripts 

Good News 
Apple and Windows both supply fonts which cover a large number of scripts (e.g. Greek, 
Russian Cyrillic, Hebrew, Arabic, Armenian, Chinese, Japanese, Korean, Devanagari) 

Bad News 
• There’s not a large selection in font variety for undersupported scripts. 
• Not everything is covered 

Key Fonts for Phonetics/Extended Latin/Grk/Cyr 
• Lucida Grande – Free from Apple with lots of glyphs. Default system and menu font. 
αβγ дпл āşɤʃɮ  

• Monaco – Free from all with lots of glyph. Suited for plain text. 
αβγ дпл āşɤʃɮ   

• Arial Unicode MS – Free from Windows with lots of glyphs. Now available on Apple as of OS 
X 10.5 
αβγ дпл āşɤʃɮ   

• Times New Roman – Actually contains Latin/Greek/Cyrillic, but not all IPA 
αβγ дпл āş 

Apple & Windows also ship with language specific fonts.  
See http://tlt.its.psu.edu/suggestions/international/bylanguage/index.html 

Insert Text in Phonetics (Manual Font Control) 
1. Insert text using methods listed above 
2. If box appears, switch to Lucida Grande or other phonetics fonts (see below) 

Note: You may need to switch 

Other Phonetic Fonts 
These also support Latin, Greek, Cyrillic other characters as indicated by developers. 

• SIL Fonts – http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&id=FontDownloads&_sc=1 
• Junicode (Medieval) – http://junicode.sourceforge.net/ 
• Aboriginal (Native American) – http://www.languagegeek.com/font/fontdownload.html 
• Quivira  (Mega Font) – http://www.grinningbit.com/quivira.php 
• Arev (Sans Serif Mega) – http://tavmjong.free.fr/FONTS/ 

See also http://tlt.its.psu.edu/suggestions/international/bylanguage/ipa.html 
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Phonetic Keyboards & Palettes 
• SIL (Mac) – http://scripts.sil.org/cms/scripts/page.php?site_id=nrsi&id=UniIPAKeyboard&_sc=1 
• IPA Palette (Mac) – http://www.blugs.com/IPA/ 
• UCL Phonetic Keyboard (Win) – http://www.phon.ucl.ac.uk/resource/phonetics/ 
• Windows IPA Palette (Win) – http://www.davidmontero.net/Linguistics.php 

 

Installation Instructions 
See http://tlt.its.psu.edu/suggestions/international/keyboards/macfont.html 

Third Party Fonts for Other Scripts 
Installation Instructions: 

• Free and for pay. Many academic consortia are developing fonts for undesupported scripts 
(as well as talented amateurs) 

• TTF and OTF fonts fine (except for Arabic/South Asia) 
• Try to get a matching keyboard! 
• SIL Fonts 

http://www.sil.org/computing/catalog/show_software_catalog.asp?by=cat&name=font 
• Alan Wood 

http://www.alanwood.net/unicode/fonts.html (Win/3rd Party) 
http://www.alanwood.net/unicode/fonts_macosx.html 

• Gallery of Unicode Fonts 
http://www.wazu.jp/ 

  


